Quick Start Guide
Tekla Offices Worldwide

**UK**
Tekla UK Ltd.
Trimble House
Gelder Road
Morley, Leeds
LS27 7JP
England
Tel: +44 113 887 9790
Fax: +44 845 519 6818
www.tekla.com/uk

**Singapore**
Tekla South East Asia
3A International Business Park
#08-01 ICON @ IBP
Singapore 609935
Tel:+65 62738775
Fax:+65 62731353
www.tekla.com/sg

**United States**
Tekla, Inc.
1075 Big Shanty Rd NW
Kennesaw,
GA 30144
United States
Tel: +1 770 4265105,
1-877-TEKLA-OK
Fax: +1 770 919 0574
www.tekla.com/us

**Malaysia**
Tekla Software Sdn Bhd
Suite B-12-5, Block B, Level 12
North Point Offices
Mid Valley City
No.1, Medan Syed Putra Utara
59200
Kuala Lumpur
Malaysia
Tel:+60 (0)3 2287 5970
Fax:+60 (0)3 2287 4950
www.tekla.com/sg

**Australia**
BuildingPoint Pty Ltd
33 Allison Street
Bowen Hills
QLD 4006
Australia
Tel: +61 7 3851 8380
Fax: +61 7 3252 1275
www.buildingpoint.com.au

**International Enquiries**
Tekla UK Ltd.
Trimble House
Gelder Road
Morley, Leeds
LS27 7JP
UK
Tel: +44 113 887 9790
Fax: +44 845 519 6818
EMail: sales@tekla.com
Disclaimer

Tedds UK Ltd does not accept any liability whatsoever for loss or damage arising from any errors which might be contained in the documentation, text or operation of the programs supplied.

It shall be the responsibility of the customer (and not Tekla)

• to check the documentation, text and operation of the programs supplied,
• to ensure that the person operating the programs or supervising their operation is suitably qualified and experienced,
• and to ensure that program operation is carried out in accordance with the user manuals, at all times paying due regard to the specification and scope of the programs and to the Tekla Software Licence Agreement.

Proprietary Rights

Tekla UK Ltd, hereinafter referred to as the OWNER, retains all proprietary rights with respect to this program package, consisting of all handbooks, drills, programs recorded on CD and all related materials. This program package has been provided pursuant to an agreement containing restrictions on its use.

This publication is also protected by copyright law. No part of this publication may be copied or distributed, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, manual or otherwise, or disclosed to third parties without the express written permission of the OWNER.

This confidentiality of the proprietary information and trade secrets of the OWNER shall be construed in accordance with and enforced under the laws of the United Kingdom.

Tedds documentation: © Tekla UK Ltd 2015 All rights reserved. Tedds software: © Tekla UK Ltd 2015 All rights reserved.

Trademarks

Tedds® is a registered trademark of Tekla UK Ltd.
Tekla Structural Designer™ is a trademark of Tekla UK Ltd.
Fastrak™ is a trademark of Tekla UK Ltd.
Orion™ is a trademark of Tekla UK Ltd

The Tekla logo is a trademark of Tekla UK Ltd.

Microsoft and Windows are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Acrobat® Reader Copyright © 1987-2015 Adobe Systems Incorporated. All rights reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated which may be registered in certain jurisdictions.

All other trademarks acknowledged.

Credits

Tekla UK Ltd would like to acknowledge the assistance of the DTI, through the Eureka CIMsteel project, in the research and development of Tedds®.

Third Party Copyrights

Portions of the Tedds® package have third party copyright as follows:
Table of Contents

Thank you ........................................ 5
Quick Start Guide (Australia) ................. 6
First Steps ........................................ 11
Using Tedds ....................................... 12
Writing Tedds Calculations - Stage 1 ......... 26
Using Library Calculations in Tedds for Word 35
Writing Tedds Calculations - Stage 2 .......... 41
Enhancing Calculations ......................... 47
Thank you

Thank you for choosing Tedds. We are confident that you will find it invaluable and we look forward to getting to know you and your business.

To get you up and running quickly, we've supplied this Quick Start Guide\(^1\) accessed through the ‘Help’ menu, which means you should be able to run or create your own calculations in about an hour. After that, you will easily go from novice to expert, simply by using the ‘Help’ menu and the manuals we've provided as PDFs.

If you have any comments or ideas about Tedds, please get in touch and share them with us. We aim to provide the very best solutions and feedback from our customers is vital to us.

Enjoy using Tedds, we look forward to hearing from you.

The Tedds team

Installation and licensing
For instructions on installing and licensing Tedds please read the Software Installation and Licensing Guide.pdf located in the root folder of the Tedds installation CD.

Footnotes
\(^1\) This document was prepared for Tedds 2015. If you are using a newer version of the software some features may vary.
Quick Start Guide (Australia)

Introduction
First of all, congratulations on your choice of Tedds and welcome to the Tedds Quick Start Guide. Tedds is a tool that will dramatically increase your productivity, and which will become as indispensable to you as your calculator, so much so that you’ll wonder how you ever managed without it. Thousands of engineers worldwide have already realised the benefits Tedds offers and so can you.

We are sure that, at the moment, you will have many questions about Tedds but probably at the forefront of your mind are:

- What is Tedds?
- Why Tedds and Tedds for Word?
- How do I use it?

That’s where this guide comes in. The best way to answer these questions is to show you, so this guide includes examples for you to do (not just to read), and thereby learn about Tedds, and how to use it, in the most effective manner possible - by doing.

First we will show you that you can be confident and productive in using Tedds in a matter of minutes. Then we will move on to show you how to realise its full potential, and how a little investment in time and effort now means that you can reap huge rewards in the future. We know that your time is precious, so let’s get started.

What is Tedds?
First of all, and most importantly, Tedds is an application written by Structural Engineers for Structural Engineers, not just a number cruncher written with accountants and scientists in mind. Furthermore, Tedds is a proven system that has been in use and development for over 20 years. You use a calculation from the Tedds Engineering Library written by our experienced in-house engineers covering a wide range of common engineering tasks, you can create and edit your own calculations, or you can mix both of these approaches.

Tedds Engineering Library

In the Tedds Engineering Library you will find calculations for determining loading...
...for the Analysis and Design of many types of elements and constructions...

...and much more. Each calculation is essentially a sophisticated design program in its own right. Every calculation you perform can be saved discretely, and re-calculated any number of times, in a matter of moments, to refine your design, or to cater for changes. But that’s not all...

Tedds Engineering Utilities
Along with the calculations in the library you also get all these great features and utilities:

- **Data Lists** make masses of engineering data easily and instantly accessible,

- **Tedds unique interactive Data Tables which feature Automatic Interpolation and Search functions,**
• These intuitive tools are integrated with all our calculations, so you have the information you need at your fingertips as you use the calculation. What's more, you can integrate Data Lists and Data Tables into your own calculations.

• Tedds has all the Engineering Values, Math and Logic functions you need, and it automatically handles Units (Metric and Imperial). You can consign your conversion factor tables to the bin - Tedds takes care of them automatically. This means that writing your own powerful calculations is very easy,

\[
15.5\text{mm} \times 0.125\text{m} \times \rho_{S4100} + 8\text{kg/14mm} = 586.6\text{kg/m}
\]
• What else do you need? How about a Section Properties Calculator that automatically determines the properties of sections composed of a huge variety of shapes and materials? With Tedds you’ve got it...

• ...and a 2D Frame Analysis Tool that can be used for linear static analysis of frames with unlimited nodes, and for multi-span Continuous Beam Analysis,

• So, as you can see, Tedds is an indispensable toolbox for the practising engineer. In fact, we believe it’s what you’ve been looking for all this time!
Tedds and Tedds for Word – What is the difference?

You can run Tedds in two modes. One - which we call just Tedds - is very simple, very powerful, completely self-contained and requires no knowledge of any other package. This mode gives you access to all the major Engineering Library calculations and utilities, and is the best place to start using Tedds. We will look at this mode first below.

The other mode - Tedds for Word - is even more powerful and is entirely integrated with Microsoft® Word - in fact it operates in Word. So, of course, you need Word (and it helps to have a little knowledge of it). In this mode you can run all the Tedds Engineering Library calculations and utilities and also have all the editing features of Word at your disposal to create really complete and professional looking reports. In this mode you can also write your own calculations.

How do I use Tedds?

Now, you probably started off asking of Tedds - What does it do? Well, we have shown you that Tedds can do so much, that a better question is:

• What do you want to do?

Take a look at the task-list below - we guess that you have needed or wanted to do most of these things some time:

• Check that a rectangular hollow section, subject to compression and bending, is OK and produce a smart, finished calculation to show this.
• Create your own custom calculations to speed up and take the tedium out of some repetitive calculations.
• Create calculations in a Word document ready to include in a report.
• Determine the load chase down and wind loads on a building and include these calculations in a final report.
• Create your own sophisticated custom calculations suitable for others to use.

If you could have done with some help with these, you have it now with Tedds.

The examples that follow will show you how easy this is in Tedds: simply do them. The examples build on one another, and so are best attempted in the order that they appear. We give you the rough time that each example will take, so you know that you have time to finish it.

Watch out for key points highlighted like this in the guide. All the information in this guide is useful and important, but this information is especially so.

For more help and tips on using Tedds don’t forget to read the comprehensive help system available in both Tedds and Tedds for Word.
First Steps

If you haven’t installed Tedds, then insert the CD into your computer’s CD/DVD drive, and follow the on-screen instructions to install it.

Once Tedds is installed, you will find its icon (shown below) on your desktop:

1. **Double-click** the icon to launch the program.

2. If this is the first time you are starting Tedds, or if you are updating from a previous version of Tedds, then you will see the Tedds Setup Wizard which allows you to configure Tedds with your company details and so on. Work through the various pages of the Wizard and when you reach the end click *Finish*.

3. The *Start Tedds* menu will display.

4. Choose the **version** of Tedds you wish to run (to start with we shall use Tedds rather than Tedds for Word) so click Tedds.

   Alternatively, you can click the *Start button* on the *Windows task bar*, select *All Programs*/Tekla/Structural/Tedds/Start Tedds.
Using Tedds

Exercise 1: Design of steel section.

In this exercise you will learn how to use any of the calculations in the extensive Tedds Engineering Library.

Allow about 15 minutes to complete this exercise.

We wish to check the following RHS steel beam:

**Design Information:**
- Design Code: AS 4100
- Dimensions; Length; = 5.0 m
- Effective length factors; = 0.85
- Design Forces; Moment; = 135 kNm
  - Shear; = 60.0 kN
  - Axial compression; = 40.0 kN
- Proposed section; RHS preferred; Grade; = C450

**Running Tedds and Locating Calculations**

You need to find an appropriate calculation, run it and enter the design information. You will see just how easy this is.

1. Launch Tedds from the icon on your desktop.

2. If this is the first time you are starting Tedds, or if you are updating from a previous version of Tedds, then you will see The Tedds Setup Wizard which allows you to configure Tedds with your company details and so on. Work through the various pages of the Setup Wizard and when you reach the end click Finish.

3. From the Start Tedds menu click the version of Tedds to run.
4. Again if this is the first time you have run Tedds, or if you are updating from a previous version you will see a licensing window. If you want to use the email option (recommended) it’s a good idea to do so now. When you are ready to proceed click Close to shut the licensing window and run Tedds (you have a two day period during which you can use Tedds without entering the unlock code).

5. Now you will see the Tedds Start Page:

   ![Tedds Start Page](image)

6. Click New Document... and you will see the Select Calculation dialog:

   ![Select Calculation Dialog](image)

7. Click on the All folder.
- The instructions about using Tedds are displayed in the right hand panel.
- Every Tedds calculation is listed in the left hand panel.
- When you click on a calculation, notes relating to it are displayed on the right side.

If the Show Examples option is checked, you will also see all of the examples that are included in the library - these demonstrate the potential scope of each of the calculations and show you the typical output.

To find a calculation – you could simply click on a folder in the list to open it, then click a heading to select a calculation. However for this example the Find in list feature will be used instead.

8. Type steel member design in the Find in list box.

Find in List will locate the first item title in the library that contains the exact text entered. Keywords in the item description are also considered provided the option to Find in item descriptions remains checked.

9. The first item in the library matching the entered text is selected - we are looking for the Steel member design (AS4100) calculation. If necessary click Next until it is selected as shown below.

Note there is also a 'Steel beam analysis & design (AS4100)' calculation available which will determine the design forces before proceeding to the design.

10. Click the Calculate button at the bottom right of the dialog: three things will happen:
    - A new calculation document will open – you will see this in the background.
    - The Interface for the chosen automated calculation will be displayed at the first page.
    - Another window, titled the Progress Log will also be displayed – we will explain this shortly.
Entering Data in the Automated Calculation User Interface

The user interfaces for all of the calculations in the Tedds engineering library use a consistent style which ensures they are easy to use. You select the design options you require and enter values for dimensions, loading etc. all of which are clearly explained. See the box below for more information.

The General Automated Calculation Interface Explained

An ‘i’ symbol (1) to the left of a variable description shows that there is more information available about this particular variable.

The yellow information area (at the top of the dialog) displays any information about the selected variable (if available). You can

In the left hand column are:

Notes - which display details on the calculations being performed,

Sketches - which display an appropriate sketch for the calculations,

Variables - this lists all the current variables, values can be selected from here to enter into the current interface,

Feedback - this allows you to send feedback to the development team,

Support - tells you how to obtain support in your region.

Enter information in the data fields. Where appropriate, variables may have validation and prevent invalid information being entered.

A button will allow you to enter more information or select a particular item.

At the bottom of the interface you can click Next to continue to the next page, Back to return to a previous page, Cancel to stop the calculations at the current point, and Finish to return the data to your calculation document.
1. In this calculation all the values for design forces and section details can be specified on the first page of the interface and the calculation results are also displayed.

Note that additional design and output options are available by clicking the appropriate buttons. There are already some example values provided for the beam design so take a moment to review the “Design Information:” on page 12. - and check to understand why you are changing the information shown above.

2. Enter the Design bending moment of 135 kNm.

3. Enter the Design shear force of 60 kN.

4. Finally for the Axial load applied, select Compression load and enter a value of 40kN.

5. Set the Steel grade to C450.

Note that as you change the values and options for your design the calculation results are immediately updated.
6. Now you need to choose a section to check, but you don’t need to go off and find a list of section properties, since all the data required can be accessed within Tedds. Click the 'Section...' button to display the Data List for steel sections.

**Data Lists**

You are now looking at a Data List: a tool that allows you to choose a section and see its properties at the click of a button.

In this case, both a 250x150x8 RHS and a 300x200x6 RHS may prove adequate but which is the lighter?

1. Click the Rectangular Hollow Section section type - this is known as the Data List page you require.
2. Select the size and thickness you require.
3. Click on the Details button to see all the properties of the selected section – (note that the details window updates instantaneously when you click on another section).

4. Check the properties of both sections. The 300x200x6.0 RHS section is lighter and may be preferred – choose this section and click the Select button to continue with the calculation using this section size.

You will find Data Lists for all kinds of engineering data throughout Tedds calculations; there are data lists for bolts, reinforcing bars, timber sections and much more. However, they all work in just the same simple and intuitive way.
5. The *Number of sections* option allows you to design beams using two or more sections. In this example a single section is sufficient so no change is required.

6. The section length (distance between restraints) is still the default 8000mm so change this to 5000mm, for both the major and minor axes.

7. The calculation results show that the section is passing all the checks but you have not yet set the effective length factors for compression buckling. Click the *Design options...* button to view another interface page.

8. Leave most of the values as default but change the value for $k_{ex}$ and $k_{ey}$ to 0.85, by typing or using the drop lists.

9. Click OK to return to the main page of the interface and check the calculation results.
10. You can now choose the level of output you require by clicking the *Output options...* button.

![Output options dialog box]

**Automated Calculations and Library items**

You have probably realised by now that this calculation caters for all kinds of steel sections, dimensions and loading. For each possibility and check, there is an *item in the Library* - in fact this calculation has over 150 items. When you use a calculation like this, Tedds automatically chooses the appropriate items for your options and input, and puts them together to make up the complete design.

11. Accept the results and continue. Note that the interface has finished and you now have a *Finish* button to click:

![Interface showing Finish button]

**The Progress Log**

The progress log helps to keep you informed about a calculations progress during lengthy calculations, it is also used by some calculations to report the status of specific checks or other pertinent information. When writing your own custom calculations you can add information to the log or you can modify the default options to provide more detailed information about what your calculations is doing which can be helpful for resolving errors.

![Progress Log dialog box]

This particular calculation does not use the progress log to report any additional information.
Experiencing Finished Calculations

OK, but how is your chosen section performing? The main interface displayed the design forces, capacities and utilisations but you may want to examine the results in more detail.

12. Scroll through the calculation and examine the moment capacity check:

<table>
<thead>
<tr>
<th>Design for bending moment - Section 5.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design bending moment</td>
</tr>
<tr>
<td>$M^* = 135$ kNm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section moment capacity for bending about a principal axis - Section 5.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective compact section modulus - cl 5.2.3</td>
</tr>
<tr>
<td>$Z_k = \min(3k, 1.5 \times Z_1) = 587800$ mm$^2$</td>
</tr>
<tr>
<td>Effective section modulus - cl 5.2.4</td>
</tr>
<tr>
<td>$Z_e = Z_k + \left((\lambda_{12} - \lambda_{21}) / (\lambda_{12} - \lambda_{22}) \times (Z_2 - Z_1)\right) = 510356$ mm$^2$</td>
</tr>
<tr>
<td>Nominal section moment capacity - cl 5.2.1</td>
</tr>
<tr>
<td>$M_E = f_t \times Z_2 = 228.7$ kNm</td>
</tr>
<tr>
<td>Design section moment capacity</td>
</tr>
<tr>
<td>$M_{22} = \phi \times M_E = 206.7$ kNm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Segments with full lateral restraint - Section 5.3.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>End moment ratio</td>
</tr>
<tr>
<td>$\beta_m = 1.000$</td>
</tr>
<tr>
<td>Maximum segment length - cl 5.3.2.4</td>
</tr>
<tr>
<td>$L_{2,M} = f_t \times (1800 + 1500 \times f_a) \times (250 \text{ N/mm}^2) / f_s = 9212$ mm</td>
</tr>
</tbody>
</table>

PASS - Design section moment capacity exceeds design bending moment

13. There’s another really important point to note about the calculations displayed – they don’t just show you results, but how those results have been arrived at.

Tedds is not a ‘black box’ where all you can see is the result, and all you can do is accept it. In Tedds you can see exactly what’s going on. You can see what checks Tedds does. What design method does it use? From where did that number come? The answers to all these questions are right there in front of you! This is a major reason why Tedds is so popular with engineers the world over.

Furthermore, if you need an example of how to write your own calculations, then look no further. That’s exactly what you are looking at - every calculation in the library is an example of how to write your own. How do I write a math expression in Tedds? How do I use logic or a math function in Tedds? Look again at the check shown above and you will see the answers to these questions. We will look more closely at how to write your own calculations beginning with “Writing Tedds Calculations - Stage 1” on page 26.
**Re-Calculating**

Changes are a fact of life for engineers, they always have been, and they always will be! You need to be able to take account of any changes and update your calculations quickly. With Tedds this is no problem.

Say that your beam needs to be 0.1 m longer since the beam which supports it needs to be moved, to avoid a clash. Is your section still OK?

1. **Click the Calculate button on the Home tab (highlighted above).**
   The calculation will run again, but this time all the information you entered last time is remembered. It’s a simple matter to change the required data.

2. **Change the distances between restraints to 5100 mm.**

3. **What is the effect of this change on the design? Check the Calculation results and/or the output to see.**

Tedds makes it easy to update calculations – simply re-calculate and you can update your design quickly.

**Hidden Text**

For those calculations that make use of the Progress Log you may notice the following message at the end of the Progress Log text:

“Note: some calculations may be in hidden text”

All the calculations performed by Tedds are available in the output and in general so they are – but at times some intermediate calculations are hidden to reduce the amount of output. It is simple to view these and to include them in your printout.

1. **Open the application’s View tab then use the Hidden Text option and examine the check again. You will see all the hidden text underlined with dashed lines.**

2. **In this example there are no hidden calculations but you will see the names of the Library items used in the output**

<table>
<thead>
<tr>
<th>Capacity factors ($q$) for strength limit states: Table 3.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity factor</td>
</tr>
<tr>
<td>Lateral restraint</td>
</tr>
<tr>
<td>Distance between major axis restraints</td>
</tr>
<tr>
<td>Distance between minor axis restraints</td>
</tr>
<tr>
<td>Effective length factors</td>
</tr>
<tr>
<td>Effective length factor in major axis</td>
</tr>
<tr>
<td>Effective length factor in minor axis</td>
</tr>
</tbody>
</table>

3. **Select View/ Hidden Text again to hide the Library item names. Now let us consider how to print calculations.”**
The Header & Printing

Obviously you want professional looking printed output. You will see that you have a header region at the top of the calculations, but how do you set its details?

1. Click the Header button highlighted above – this opens a dialog where you can enter the information you want. Enter the project details shown below, or something similar, for your header.

2. On the Company page you can define your own company details. Do this now, if you want to. If you don’t, then remember to do so before you print your first “proper” set of calculations.

3. On the Template page you will see the Tedds template which your calculations will use and the logo file which Tedds will add to the template. You can change the template and logo if necessary – click this tab and check that its details are correct.
4. Maybe you would like to try a different style of template, there are a number of standard templates to choose. Click the Select... button to see these. Choose the template you want to use and you will see a preview of what calculations produced with that template will look like. When you have found the template you want to use click OK to use it.

5. If you have a copy of your company logo in electronic format, and the template style you select supports a logo, then you can add your logo to the template. Make sure that the logo is available on your computer, Browse to find it, and then click OK to add it to the template.

6. Click OK to exit the Header Properties dialog and view your finished calculation.

7. Select File/Print Preview to see how it will look printed. If necessary open the Header Properties dialog and change the Scale of the logo to make it fit the template correctly. Once the template and logo are correct Print the calculation and examine your hard copy.

8. Congratulations, you have produced your first piece of work with Tedds!

To finish this example let’s look at a few points about saving and outputting your results.

**Saving and Output Options**

You can save every Tedds calculation to a unique file that you can recall and edit any time in the future. The file extension .ted is unique to Tedds.

1. Click 📀 to display the File Menu.

2. Save your file and give it a name - it’s a good idea to save all the examples you will produce in the course of completing the guide, for future reference.

3. The output you see in the document can be printed direct to a printer, but you have other options.

4. Click the drop-down button adjacent to Send To on the File Menu to view these.

5. Choose the option of sending the output to Word and experiment with the other options if you wish. Once your output is in a Word document, you can edit it as much as you wish.

**Performing a New Calculation**

How do you start a new calculation in Tedds?

1. Click 📀 to display the File Menu; then click 📀 The Select Calculation dialog will open, from where you can select and start a new calculation in a new document.

**Managing Multiple Related Calculations**

Can several calculations be saved in a single document?

As stated earlier, each calculation must be saved to a unique file - however multiple files can be collected together in a single project. They can then be organised as required using the Project Manager.

Benefits of projects include:

- you can specify a shared document header for all the project files,
• locating files is made easier - when you open the project all files within it are opened automatically,
• calculations can be placed into named groups, making them easier to manage.

To start a new project:

1. Click to display the File Menu; then from the menu choose the New Project button.

   ![Image showing File Menu with New Project button]

   A new empty project is created in the Project Manager.

2. New or Existing Documents are then added and arranged into folders as required via the Project tab.

   ![Image showing Project Manager with documents and folders]

Tedds 2015
What Next?

Congratulations! You have completed the first exercise and now know all you really need to make use of the wide range of calculations available in the Tedds Engineering Library and to begin using Tedds productively. Take a look through the index and try some more. How about:

- carrying out a wind load calculation?
- designing a retaining wall?
- designing an RC footing?
- analysing and designing a timber rafter, beam or post...

The choice is yours, and all these calculations work in the same straightforward, intuitive way. Some calculations may also include Data tables which are designed to look like tables from printed references, so that you immediately feel at home with them. Indeed we hope you will find yourself recognising them.

What can you do if the Library does not contain the exact calculation for which you are looking? You need to perform a number of calculations, and could do with a calculation to help you out with these. First of all, TELL US:

- if you are running a calculation, then you will see a Feedback button to the left-hand-side of the interface,
- if you are not running a calculation, then you can choose the Feedback... option from the Help menu.

We are constantly working to expand our Engineering Library and your input helps us do this!

But you don’t have to wait until we produce these for you – you can write them yourself. We will look at this in the next example.
Writing Tedds Calculations - Stage 1

Having looked at using calculations from the Tedds Library we can move on to look at one of the most exciting and powerful features of Tedds - the ability to create your own calculations. This is where an initial investment of time can give you huge returns later. Once you have invested time writing a Calculation, you can use it over and over again, you can also update calculations in an instant, making further great savings. You can also customise and extend the Library of Tedds calculations to match the calculations that you use most frequently in your office.

Exercise 2: Writing Tedds Calculations

In this exercise we will see that writing Tedds calculations simply uses the math and logic conventions with which you are already conversant. We start by looking briefly at very simple examples introducing the basics of calculating with Tedds for Word. We then create a “real-world” example, covering the main features of writing effective calculations in depth.

Allow about 30 minutes to complete this exercise.

Running Tedds for Word

To write calculations you need to use Tedds for Word.

1. Launch Tedds from the icon on your desktop
2. Choose the option to run Tedds for Word then click Start.
3. Click OK - Microsoft Word will now open with Tedds integrated. If this is the first time you've run Tedds for Word a Release Notes document and the Library Access System will open too.

It is important to realise that you are looking at Microsoft® Word with the Tedds capabilities added. We only add to the functionality of Word, so you can do anything you would normally do in Word. Treat a Tedds Calculation Document just like you would any ordinary Word document. You can type reports, import files and text, embed spreadsheet and so on. And of course you can add calculations to your reports; either straight out of the Tedds Engineering Library, just as you did in the previous exercise, or create your own.
The Tedds interface
The commands you will need to use in this exercise can all be found on the Tedds Tab of the ribbon as highlighted below:

You will find a Word Document open, which looks very similar to the Tedds output document.
The document Header can be edited in a similar manner to that in Tedds by clicking the Edit Header button - this button is highlighted above.

1. In this exercise two documents will be required, so open a new blank one by selecting File/ New Tedds Document.
Now we are ready to begin writing our first calculation in Tedds.

The Basics
Writing calculations in Tedds for Word is easy. Tedds follows standard mathematical rules and uses standard mathematical operators. For example 1 + 2 would add 1 to 2. To write an equation use the = sign, and to specify where you want to see the answer use the ? symbol. For example:

\[ 1 + 2 = ? \]

1. Type the above anywhere in your document. When you calculate this equation the ? will be replaced with the answer.

Calculating in Tedds for Word
To calculate equations in Tedds you can use one of several icons:

- **All** - this will calculate the whole document.
- **Calculate Section** - this will calculate the Calc. Section your cursor is in.
- **Calculate Selection** - this will calculate only equations you have highlighted

2. Click the Calculate All button to calculate your equation:

\[ 1 + 2 = 3.000 \]

3. You should find the answer displayed in your document as shown above. If you have an error, turn to “Errors and Troubleshooting” on page 33.
Units in Tedds

Tedds automatically takes units into account, so you don’t need to apply conversion factors to get the right answer. Tedds will also check that the units you are using are dimensionally correct and warn you if they aren’t.

1. Type the following in your document using the same case as you see here:

\[ 890 \text{ mm} + 1 \text{ ft} + 8.5 \text{ in} = ? \text{ m} \]

2. Click the Calculate All button to calculate this equation:

\[ 890 \text{ mm} + 1 \text{ ft} + 8.5 \text{ in} = 1.411 \text{ m} \]

3. You should find the answer displayed in your document as shown above. If you have an error, turn to the section “Errors and Troubleshooting” on page 33.

Defining and Using Input Variables in Tedds

Defining variables is the key to writing effective Tedds calculations. We will use the following calculations to demonstrate this. Do not type this yet - we will show you how to enter the calculation below (in stages) in the following couple of pages.

STEEL SECTION TIE DESIGN

Yield strength; \( f_u = 430 \text{ MPa} \)
Design strength; \( f_y = 0.8 \times f_u = ? \text{ MPa} \)
Tie force; \( N = 675.0 \text{ kN} \)
Min. gross section area; \( A_{min} = N / f_y = ? \text{ mm}^2 \)
Tie effective length; \( L_e = 5 \text{ m} \)
Slenderness limit; \( \lambda_L = 300 \)
Min. radius of gyration; \( r_{min} = L_e / \lambda_L = ? \text{ mm} \)

1. Close the current document, (because two documents were opened at the beginning of the exercise you should still have an empty one displayed).

2. Type in the following two paragraphs in the empty document.

STEEL SECTION TIE DESIGN

Yield strength; \( f_u = 430 \text{ MPa} \)

3. The first paragraph is just a title for our calculation. The second paragraph is a standard Variable Definition.
4. Once you have finished typing, read the notes in the box below for an explanation of a standard variable definition, and to check you have typed it correctly.

**The Standard Variable Definition Explained**

Yield strength ; \( \text{fu} = 430 \text{ Mpa} \)

Note the following:
- The expression *defines* the variable’s *unique name*, current *value* and *units*.
- Variable names are *case sensitive*, cannot contain spaces or be *function* names (like \( \text{sin} \) for example). Other than that you can use pretty much anything you like as you can see, including **Greek** text and **Subscripts**.
- The semi-colon is important. It is a *delimiter* that separates an expression from text, or another expression in the same paragraph. If you omit delimiters in either of these cases, then you will get an error when you calculate your document.
- The equality sign '=', *defines* an expression. Without it no calculation will be performed.
- **Spaces** and **Tabs** are *not* significant in this, or any other, expression. Use as many or as few as you wish to make your calculations look presentable and easy to read.
- We will look at **Units** in more detail shortly but, for now, note that they are also case sensitive and have a correct syntax, that you must use (as shown above).

5. Now enter the following paragraph which uses this variable:

\[
\text{Design strength;} \quad \text{fy} = 0.8 \times \text{fu} = ? \text{ MPa}
\]

6. Use the *Multiply Symbol* button to enter the \( \times \) mathematical operator - **do not** use a lower-case x
7. Check the notes in the box below for a detailed explanation of the components of this paragraph.

**Mathematical Expressions Explained**

- Design strength;

  \[ fy = 0.8 \times Fu = ? \text{ Mpa} \]

  - The same observations as before apply to delimiters, explanations, spaces and units.
  - You cannot omit math operators in expressions: Tedds cannot calculate 0.6Fu, you must type the expression as shown above, including the \( \times \).
  - The result field ? is used to tell Tedds where the result should be output - when calculated the ? will be replaced with the result of the expression.
  - The value of the result will be in the result unit you specify. Ensure this has the correct form and dimensions. Do not omit this.
  - The expression contains a variable (Fu) that is defined in the calculations before (that is above) the point where it is used. Expressions should not contain variables that are not yet defined.
  - The expression contains two equalities and performs two functions:
    - calculates and displays the value we wish to know - the result.
    - assigns this result to a variable named - fy
  - It is not obligatory to always do this. You can write a valid expression to perform just one of these functions by either omitting the variable name and the first equality, or the second equality and the ? and unit.

8. Now click the Calculate All button to calculate your calculation.

\[ fy = 0.8 \times fu = 344.000 \text{ MPa} \]

9. Your expression has been calculated and the result has replaced the ? as before. If you have an error, turn to “Errors and Troubleshooting” on page 33.

10. Here are the next two paragraphs of the calculation. The first paragraph is a standard variable definition, while the second uses both \( N \) and \( fy \) to determine the minimum section area and creates a variable \( A_{min} \) with this value.

   Tie force:
   \[ N = 675.0 \text{ kN} \]
   Min. gross section area: \[ A_{min} = \frac{N}{fy} = ? \text{ mm}^2 \]

11. Type the first paragraph, then follow the steps below to enter the second.

12. The second paragraph contains examples of the use of subscript (often used for name suffixes) and superscript (used for powers).

13. To type the variable name \( A_{min} \), first type the \( A \), then click the Subscript button:

14. Now type \( min \), then click the button again to return to normal text.
15. To type the unit \( \text{mm}^2 \), first type \( \text{mm} \), then click the **Superscript** button:

16. Now type 2, then click the button *again* to return to normal text.

17. Click **Calculate All** to calculate these expressions once you have entered them.

\[
\text{Min. gross section area; } A_{\text{min}} = \frac{N}{f_y} = 1962.209 \text{ mm}^2
\]

18. You should find the result displayed in the document - if you have an error, turn to “Errors and Troubleshooting” on page 33.

19. Here are the final three paragraphs of the calculation. Follow the steps below to create these.

\[
\begin{align*}
\text{Effective length; } L_e & = 5 \text{ m} \\
\text{Slenderness limit; } \lambda_L & = 300 \\
\text{Min. radius of gyration; } r_{\text{min}} & = \frac{L_e}{\lambda_L} = \text{? mm}
\end{align*}
\]

20. Here we define two new variables to be used in the expression on the final paragraph.

21. Type the first paragraph, entering the *subscript* for the name \( L_e \) as you did before.

22. Follow the steps below to enter the second paragraph.

23. Use the **Greek Text** button to enter the name \( \lambda_L \)

24. First click the button indicated, then type the Roman equivalent of the Greek letter – \( \ell \) in this case for lambda).

25. Now click the button *again* to return to normal text, then enter the *subscript* suffix as you did above using the **Subscript** button.

26. Use **Copy** and **Paste** to enter this name in the final expression.

27. Now click **Calculate All** to calculate these final expressions:

\[
\text{Min. radius of gyration; } r_{\text{min}} = \frac{L_e}{\lambda_L} = 16.667 \text{ mm}
\]

28. You should find the result displayed in the document - if you have an error, turn to “Errors and Troubleshooting” on page 33.

---

**Greek Text**

A much easier way of entering Greek characters and more complex units is to use the Tedds **Greek Characters**, **Tedds SI Units** and **Tedds US Units** toolbars. Word 2003 users simply pick Tedds/Toolbars... menu option and check the appropriate options. Word 2007 - 2010 - 2013 users can select directly from the Tedds Tab on the ribbon.
Storing Variables in Tedds

1. Click the Variables button.

2. The Variables dialog will open, displaying the stored values.

3. You will note that we do not just store the variable name and value, but also the dimensions. This is how Tedds handles all the unit conversions for you.

4. **Cancel** from this dialog, and edit one of the values on the page - say the tie force to $N = 600 \text{kN}$. Now check back in the stored variables and you will note the stored value has not changed.

5. **Re-calculate** the document and check back in the list of variables - the new value has now been stored.

   An important observation — the stored value of a variable only changes when you re-calculate the definition, not when you just edit it on the page. If you edit the value of a variable you must re-calculate the variable definition, and any calculations that use it to update them.

More About Units in Tedds

6. Change the tie force back to its original value $N = 675 \text{kN}$. Calculate again to store this new value.

7. Look again at the values displayed in the Variables dialog. You will note that many of these values are not those displayed in the document.

8. The values in the dialog are in the **Base Units** in which Tedds performs all calculations and from which all the other units are derived. The base units are shown in the following table:

<table>
<thead>
<tr>
<th><strong>Tedds Base Units</strong></th>
<th><strong>Metric</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>m</td>
</tr>
<tr>
<td>Mass</td>
<td>kg</td>
</tr>
<tr>
<td>Time</td>
<td>s</td>
</tr>
<tr>
<td>Temp</td>
<td>°C</td>
</tr>
</tbody>
</table>

If you hover over a variable name in the Variables dialog a summary list is displayed showing the value of the variable in all applicable standard units.
9. Note that our calculation does not include any conversion factors.

Tedds’ unit handling is a massive help – Tedds comes with a huge number of defined units and you can add more if needed.

**Dimensional Checking** - Tedds checks all dimensions in your calculation and will inform you if these are incorrect. This is why you should use units consistently throughout your calculations. Do so, and you can have total confidence that your calculations are dimensionally correct.

10. Save the document and give it a name - call it “Exercise 2” - as we wish to build on it later in the guide.

**What Next?**

Congratulations! You have completed your first Tedds calculation. You can now begin writing effective calculations in Tedds for Word. There are more great features that make such calculations even more powerful, and we will show you these later.

Right now we will take a brief look at handling errors in calculations.

**Errors and Troubleshooting**

The problem with a lot of guides is they only show you the right way to do things, and then you have no idea what to do when something goes wrong! Let’s look at a couple of errors and how to fix them.

1. If you have an error in your calculations, Tedds will inform you when you calculate your document and the error is encountered. The first thing you should do is **Interrupt** the calculation process.

2. If you have jumped to this section because you have encountered an error previously, then click the **Interrupt** button in the dialog (see step 10 below), review the details from step 11 onwards and then return to fix the error in your calculations and continue with the exercise.

3. If your previous calculations were error free, then you will have had no need to look at this section. We shall therefore create some calculations which do have errors so that we can see how to handle them. Open a new blank document for this example.

4. Click the **Tedds Options** button.

5. The **Options** dialog will open, click on the **Calculating / General page**.

![Options dialog](image.png)
6. Make sure that the options above are checked and then click OK. We can now proceed to create some calculations with errors.

7. Enter the following 2 paragraphs as they appear here - see if you can spot any errors as you do, but don’t fix them yet!

\[ w_L = 4.5 \text{ kPa} \quad w_D = 2.5 \text{ kPa} \]
\[ w_T = w_L + w_D \] ? kPa

8. Now click the Calculate All button to calculate the calculations - you should see the Expression Error dialog:

9. Tedds flags the first error, and gives you some help in fixing it.

10. When you are ready, click the Interrupt button. Tedds highlights the error for you in the document as shown below:

\[ w_L = 4.5 \text{ kPa} \quad w_D = 2.5 \text{ kPa}<\text{Error: invalid expression}><\text{interrupted by user}>\]

Once we fix the problem and re-calculate this error messages will automatically disappear.

11. Check the rule about delimiters (see “The Standard Variable Definition Explained” on page 29.) There should be a semi-colon between the expressions to separate them. Add this in and re-calculate the entire document.

\[ w_L = 4.5 \text{ kPa} \quad w_D = 2.5 \text{ kPa}\]

12. Now we will get the next error – the variable WD is not defined. We have typed WD instead of wD and variable names are case-sensitive.

13. Click the Interrupt button to stop the calculation.

14. Correct the variable name on the page to wD and re-calculate. The calculations should now complete with no problems. Tedds automatically deletes all error messages from the page.

What Now?
When you have successfully completed this section, you can move onto the next topic. Now we are going to look at using calculations from the Engineering Library in Tedds for Word.
Using Library Calculations in Tedds for Word

Why use Library Calculations in Tedds for Word?
We have shown that you can write your own calculations in Tedds for Word, but you can also use the Library Calculations. The advantage of this is that you can add additional text to your output easily, because it is already in a Word document. You can also combine more than one calculation in a document, add pictures and tables - anything you need to create a polished report. And if you need to update the calculations you can do it directly in the document.

Sometimes, of course, you just need an answer right now and the polishing can wait. That's why we have Tedds too. With the two modes, you have both bases covered.

Exercise 3: Using Library Calculations in Tedds for Word
In this exercise we will use the RC circular column design calculation to show you how to run a typical calculation from the extensive Engineering Library in Tedds for Word.

允许大约 15 分钟来完成这个练习。

Design Information
Use the following information for the calculation.
Column state = Braced
Length of column = 3000 mm
Diameter of column = 300 mm
Effective height factor = 1.0
Concrete characteristic compressive strength = 32 MPa
Reinforcement yield stress = 500 MPa
Reinforcement bar size = 20 mm
Fitments bar size = 6 mm
Nominal concrete cover = 30 mm
Exposure classification = A1
Design axial load = 600 kN
Smaller end moment = 25 kNm
Larger end moment = 60 kNm
Ratio of axial dead load to total axial load = 0.65
Buttons used in this Exercise
The new commands you will be introduced to in this exercise are located on the Tedds tab as shown below:

Using Calculation Sections in Tedds for Word
As stated, one of the reasons for running library calculations in Tedds for Word is so that you can combine a number of calculations in a single document. In this case, each calculation should be placed in a separate Calculation Section, so we will start off by introducing these. For more information on this topic see “Calculation Sections Explained” on page 40.

1. Open a new document.

2. Insert a New Calc Section by clicking the appropriate button.

3. The following dialog will appear - enter a name for the section. This will form the title for the calculation in the document.

4. Click OK and this will enter a Calculation Section Title in the document. We place a calculation below this title and thus within the section. You should note that your cursor is now on the line below the section title.

Retrieving and Using Calculations from the Library
All the library calculations are available from the Library Access System. To run a calculation we retrieve it from the Library, place it in our document and calculate it.
1. If it is not open already, launch the Library Access System.

2. Click the Index button if the index is not displayed and ensure you have the Tedds Calculations index option selected.

3. To open a folder in the index simply double-click it. Open the Columns folder then the RC column design (AS3600) folder. Then select (click on) the RC circular column design (AS3600) item.

4. To place this calculation in the document, click the Execute button in the library. (You can also double-click on the selected item to do this.) In both cases you will see the Insert Calc Item dialog.

5. This dialog allows you to control where the item will be added. Simply click OK and the item will be pasted at the cursor position in the document.

   Note that you can also create a Calc Section directly from the Insert Calc Item dialog.

6. You should now have the following in your document.

   **RC COLUMN DESIGN**
   
   RC Circular Column Design (AS 3600)
7. We can now close the Library - there is no need to have it open while a calculation is running.

8. Click the Calculate Calc Section button to start the calculation.

9. The Interface for the calculation will now be displayed, along with the Progress Log. You are now in familiar territory as everything from this point works exactly as you learned in the first exercise – Using Tedds (page 12).

10. Enter the options given under Design Information on page 35 for the first page of the interface. You will be comfortable with entering information in the interface by now, so we won’t show every page in the guide.

11. Continue to enter the reinforcement information on the second page. At this point we don’t know how many longitudinal bars will be required so accept the default of 6.

12. When you get to the Exposure classification, note the help information available for the input displayed in the information pane (as shown below).

13. Fire resistance and any other data not specifically specified can be left at the default value.

14. Proceed to the third page and enter the design loads.

15. Click Next to complete the interface and the calculation will be performed.

16. Review the calculation result summary displayed in the interface. The current configuration is clearly not suitable as there is insufficient moment resisting capacity.
17. Click Back two times to return to the reinforcement page. Increase the number of longitudinal bars to 8 and then progress to the result summary once again. The revised configuration should now be acceptable.

18. The dropdown at the bottom of the page allows you to choose the amount of output you require. For this example pick the Full option. Also check the box to include a sketch and then click Finish to close the interface and generate the report.

19. Close the Progress Log and examine the calculations in the document - they are of the same form as the ones you saw in Tedds, and they show you exactly how the results have been determined.

**Viewing Hidden Text in Tedds for Word**

This particular calculation has no hidden text. It is worth pointing out that some do, and that there is a slightly different way of viewing Hidden Text in Tedds for Word.

20. Check the Hidden Calcs box to view these.

21. Check the button again to re-hide text.

**Re-calculting in Tedds for Word**

This is accomplished in a similar manner to Tedds.

22. Click the Calculate Calc Section button.

23. The calculation will now run again - try changing some of the input data in the interface.

24. **DO NOT** overtype values on the page prior to re-calculting - this is not the way to change input data when using our library calculations (as distinct from ones you have written yourself in the manner shown in the previous section of the guide) in Tedds for Word.

**Adding another calculation to the document**

To start a new calculation in this document create a new Calculation Section.

25. Place your cursor below your existing calculations.

26. Click the Add New Calc Section button.

27. Type in a name for the new section – this will form the title for your next calculation. Click OK to enter the new section.

28. A new calculation should be placed below this title and thus within the section.

29. Retrieve another calculation from the library and place it within this section.

30. To calculate just one section, we place our cursor within the section and use the Calculate Calc Section button.
Calculation Sections Explained

Refer back to the section “Storing Variables in Tedds” on page 32. You will note that here we have just one list of saved variables, known as Document variables, as we have not used Calculation Sections. When we use Calculation Sections, Tedds for Word saves the variables for each calculation in a separate list unique to each section. These are known as Section variables. This ensures that all your input values are retained separately from those for another calculation.

When you need to update a single calculation within a document that contains many calculations, simply place your cursor within that section and use the Calculate Calc Section command. Place your cursor within the first section in your document, and click the Variables button to view the unique list for this part of the document.

Tedds for Word also has commands which enable you to manipulate the calculation sections in your document. You can delete a calculation section, copy it, paste it into a new location in your document and change its name.

What Next?

Congratulations! You have completed the third exercise of the guide and learned all you need to run calculations from the Library in Tedds for Word.

You can now save the document and re-use it as appropriate.

In the next section you will learn how you can make your own calculations even more powerful.
Writing Tedds Calculations - Stage 2

Exercise 4: Using Math and Data functions and Formatting Results

In this exercise we will build on the calculation we wrote in Exercise 2 to extend its capabilities and introduce some more Tedds features.

Allow about 30 minutes to complete this exercise.

Buttons used in this Exercise

The new commands you will be introduced to in this exercise are located on the Library and Show/Hide groups of the Tedds tab as shown below:

![Tedds Tab with Buttons Highlighted]

Defining Input Variables

1. Open the document you created in exercise 2 - “Exercise 2”.

2. Here are the new calculations we will add to check the adequacy of an actual section:

   **Check section:**
   - Try a 150 Parallel Flanged Channel
   - Section properties: \( A = 2254 \text{ mm}^2; \) \( r_x = 60.8 \text{ mm}; \) \( r_y = 23.9 \text{ mm} \)
   - Design radius of gyration: \( r_d = \min(r_x, r_y) = ? \text{ cm} \)
   - Actual stress: \( f_a = \frac{N}{A} = ? \text{ MPa} \)
   - Actual slenderness: \( \lambda = \frac{L_e}{r_d} = ?f1 \)

3. Type the first two paragraphs, which are just text, below the existing calculation.

4. Type the third paragraph and note that here we are defining three input variables which are properties of the section we are checking. Ensure you separate the text and all the expressions using delimiters (;) as shown.

   Section properties: \( A = 2254 \text{ mm}^2; \) \( r_x = 60.8 \text{ mm}; \) \( r_y = 23.9 \text{ mm} \)

Tedds Math Functions

5. Now type the fourth paragraph. Note how the Tedds math function \( \min \) is used here.

   Design radius of gyration: \( r_d = \min(r_x, r_y) = ? \text{ cm} \)
6. Now type the fifth paragraph - this is a simple expression that determines and displays the actual stress in the section and assigns the result to the variable $f_p$.

### Result Accuracy and Formats

It is sufficient to display the slenderness to one decimal place. To do this we use a **format string** to override the default result setting of three decimal places.

7. Now type the last paragraph of the new calculations as follows. Use the **Greek text** button as you did on page 31 for the variable name $\lambda$.

$$\text{Actual slenderness:} \quad \lambda = \frac{L_e}{r_d} = ?f1$$

8. The characters *f1* following the ? are the **format string**. The format string must immediately follow the ? with no space in between as shown. See below for a fuller explanation.

9. Once you have finished typing this last expression, check the new paragraphs carefully. Have you included all the *delimiters*? Have you used *subscripts* correctly? Have you used the correct *case* for variable names and units?

10. When you are satisfied that everything is correct, click the **Calculate All** button.

11. If you have an *Error*, then **Interrupt** and see “Errors and Troubleshooting” on page 33. Fix any errors until your calculation works fully.

12. Review your results and look at the last paragraph to see how the format string we used has operated:

$$\text{Actual slenderness:} \quad \lambda = \frac{L_e}{r_d} = \mathbf{209.2}$$

13. Click the **Variables** button to examine the list of saved variables and check the *stored* value for this variable:
Using Data functions in calculations

The calculation as written is very useful, but we can enhance it further. One big improvement is to include a Data List in the calculation, making the properties of a huge number of types and sizes of sections instantly available.

1. First edit the two paragraphs underneath the heading ‘Check Section;’ as follows:

2. Delete the following text for the section name - Try a 150 Parallel Flanged Channel. Leave an empty line here.

3. Next delete just the values for the properties of the section. Replace them with a ? result field. You should end up with the following:

   Place cursor here

   Check section;

   Section properties; A = ? mm²; rx = ? mm; ry = ? mm

4. Finally, place your cursor as shown at the very end of the heading.

Retrieving Data Lists from the Library

5. Click the button to Launch the Tedds Engineering Data.

6. This opens a special Set in the Library where all the Data Lists and Data Tables are accessed. There is a lot of data in this set. We wish to find a Data List that includes steel properties suitable for an AS 4100 calculation.

   We will use the Find facility to help us locate such a table.
7. First select the Group we want to search in - Australian standards. Select Edit/Find in the library, and type in AS 4100 as shown.

8. Library Access System finds the AS 4100 group which contains the data lists which are appropriate for AS 4100 design, click the plus sign to the left of this group. Pick the Steel sections data list (AU) item which is also highlighted above.

Steel sections data list (AU)

9. Now to bring this item into your calculation, either double click the item, or click the Execute... button. You should find the following has been entered in your document.

Check section;
DataList("aussie.dis","Universal Beams","150(60(14))","Try ","")
Section properties;
\[ A_0 = ? \text{ mm}^2; r_i = ? \text{ mm}; r_f = ? \text{ mm} \]

10. This text inserted is a Tedds Data List Field which launches the specified Data List (further details on Tedds Fields are given below),

11. Close the library once you have retrieved the Tedds Data List Field.

12. Now click Calculate All to calculate the document again.

13. The Data List will now be displayed when the Tedds Data List Field is calculated:
14. Select the 150 channel section then click on the Details button to examine the variables defined in the table.

Note that although we have used exactly the same names for the radii of gyration in our calculation as those defined by the Data Table, \( r_x \) and \( r_y \) we have defined the area as \( A \). In the Data List the area of the section is named \( A_g \). If we don’t use the same names, then our calculations will not integrate correctly. We therefore need to change the variable name in our calculations (\( A \)) to that held in the Data List (\( A_g \)). The variable is used twice.

15. Click the Select button to return these variables to your calculations - you will see that the section’s properties from the Data List replace the \( ? \) fields in your document and the Tedds Field displays the choice you made in the Data List.

Try 150 PFC;
Section properties;
\[ A_g = 2254.000 \text{ mm}^2; \quad r_x = 60.830 \text{ mm}; \quad r_y = 23.880 \text{ mm} \]

16. The Data List is now integrated with your calculation. Re-calculate a few times, each time changing your selection of channel size in the Data List, to test this.

17. Click the Variables button and you will see that all the variables defined by the Data List are listed and are thus available to be used in calculations.

18. Save the calculation at this stage, as we will build on it in the final exercise.

19. Data Tables can be integrated with your calculations in exactly the same way.
Tedds Fields

20. Check the Field Codes box.

21. Look at the Tedds Field in your document and you will see the following:

Check section;
{ =CSC|CALL DataList("AUall.dls", "Parallel flange Channels", "150", "Try ", ",", "Current_section", "Current_page") }

22. The command that runs the Data List is now revealed. Uncheck the Field Codes box again to return to the normal view of the document.

What Next?

Congratulations! You have completed the fourth exercise and learned everything you really need to write powerful Tedds calculations. Maybe now would be the time to have a go at writing a calculation of your own. It’s a good idea to start with something simple and build on the complexity as you become more familiar with Tedds.

The next step in the guide is about making Tedds calculations still easier to work with, and is especially relevant if you envisage writing calculations for others to use. Even if your calculations are for your own use you may find these further features beneficial so we recommend that you review them. You might like to leave this step until you have had a go at writing a calculation of your own using what you have learned so far.
Enhancing Calculations

There is even more functionality available for our calculations than we have seen so far. Whether you use these enhancements depends both on the purpose of the calculation, and on the time you have available. Certainly these features are very useful when you are writing calculations which others will use (as we do at Tekla). Hence the Tedds library is packed with examples which use these features, and you have already seen many of them when running our calculations.

Exercise 5: Enhancing Calculations
In this exercise we will enhance the previous calculation and you will see what we are talking about.

Allow about 15 minutes to complete this exercise.

Buttons used in this Exercise
The only new command you will be introduced to in this exercise is located on the Insert group of the Tedds Calcs ribbon as shown below:

Tedds Input Fields
The Tedds Input Field speeds up the editing and often the creating of input variables. We will replace all the existing variable definitions in the calculation:

1. Delete the entire definition for the Yield strength, fu, from your page. Leave your cursor on the empty line.
2. Click the Tedds Field button.
3. The following dialog will appear. Enter the details shown to define the input for this variable:

   Prompt = Yield strength
   Name = fu
   Units = MPa
   Default value = 0
   Format = Fixed
   No. of decimal places = 0
4. Note that we do not put a value in this dialog - this is entered when the statement is calculated. Note the following:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>tells the user what the variable is and appears on the page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>the unique name of the variable</td>
</tr>
<tr>
<td>Units</td>
<td>if the property has dimensions then enter a unit here</td>
</tr>
<tr>
<td>Default value</td>
<td>this value will be displayed initially for user to edit or accept</td>
</tr>
<tr>
<td>Format</td>
<td>the format displayed on the page</td>
</tr>
<tr>
<td>No. of decimal places</td>
<td>the number of decimal places displayed on the page</td>
</tr>
</tbody>
</table>

5. Accept the defaults for other options and click OK when you have everything entered.

6. The following will appear on the line containing your cursor:

   ; Yield strength; fu = ?F0 MPa;

7. With the Field Codes button on you will see the following Tedds Input Field preceding the text on the line.

   { =CSC|CALL Input("Yield strength","fu","MPa","430",1) }; Yield strength; fu = ?F0 MPa;

8. Calculate your document to run it:

9. The Set Variable Value dialog appears, as shown above.

10. Because we already have a value defined for this variable it is displayed in the input. You can accept it, or edit it as required. There is no need to find and edit the variable value on the page, as it is automatically updated when you enter a value in the Set Variable Value dialog.
11. Delete and replace the 3 remaining variable definitions in the same manner – the table below shows what you need to enter in the Insert Tedds Field dialog for each of the three variables in order from left to right. When you have done this, recalculate your document to ensure that your definitions are correct.

<table>
<thead>
<tr>
<th>Property</th>
<th>N</th>
<th>Le</th>
<th>λL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Tie force</td>
<td>Tie effective length</td>
<td>Slenderness limit</td>
</tr>
<tr>
<td>Name</td>
<td>N</td>
<td>Le</td>
<td>λL</td>
</tr>
<tr>
<td>Units</td>
<td>kN</td>
<td>m</td>
<td></td>
</tr>
<tr>
<td>Default value</td>
<td></td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>fixed</td>
<td>fixed</td>
<td>fixed</td>
</tr>
<tr>
<td>No. of decimal places</td>
<td>2</td>
<td>3</td>
<td>0</td>
</tr>
</tbody>
</table>

To enter Greek characters in the Insert Tedds Field dialog for variable names like λ, simply click the Greek character button (σ) and then type in the equivalent Roman character, in this case you need to type l (i.e. lowercase letter L) to get λ.

To enter Subscript or Superscript characters simply click the Subscript or Superscript button (σ) and then continue and type in the subscript or superscript. Once you have reached its end click the button again to switch back to typing normal text.

The Default value is entirely optional. If you enter one it will be displayed the first time a calculation is run, otherwise the input box will be empty. Delete the stored variables and recalculate to see the defaults in operation.

Tedds Interface Designer

Although The Tedds Input Field can be used to create all the variables required in a calculation, if you would like to give your calculations a slicker appearance we would strongly recommend using the Tedds Interface Designer instead. This easy to use tool allows you to place all the input variables on a single interface along with sketches and notes if required. For a worked example and further details of how to use the Tedds Interface Designer refer to the Tedds for Word Help.
The final thing we would like the calculation to do is automatically assess our section and report in the document whether our chosen section is passing or failing and, if it is failing, why. We use a *Tedds Show Field* to do this.

1. Enter the following two paragraphs after your existing calculations:

   Check stress; \[ \text{check\_stress} = f_s / f_y \]
   Check slenderness; \[ \text{check\_slenderness} = \lambda / \lambda_c \]

2. These last two values help us assess the *utilisation* of the section for the two checks. Assigning them to *output variables* will help us with creating Tedds Show Fields. Calculate your document once you have written them to ensure they are working properly before proceeding.

3. Place your cursor beneath these paragraphs and click the *Insert Tedds Field* button.

4. Select the *Show* tab. The Show Field we want to create will test whether the section is failing *stress* and output a message to give the status of the check.

5. Select the *Condition* type option and input the following information:

   ![Insert Tedds Field dialog](Image)

   - The output of the *Tedds Show Field* consists of two text messages known as *output strings*. Only one output string is displayed in the document depending on the status of the condition.

6. Check your input carefully, then click *OK* to enter the Tedds Show Field in the document.

7. When you have *OK*’d the input, click the *Field Codes* button to view the resulting Tedds Show Field. It should be as shown below. If your Tedds Show Field is incorrect, the best thing to do at this stage is to delete it and run through the *Insert Tedds Field* dialog again.

   ```csc
   =CSC[CALL Show(if(check\_stress > 1,"Section fails stress check","Section OK for stress"), Show, True, True)];
   ```
Using Logic In Tedds

9. Take a close look at this Tedds Show field, and you can see how we use a simple logic statement to output one of two pieces of text using the if logical operator.

   \[ \text{if}(\text{check\_stress} > 1, \text{“Section fails stress check”}, \text{“Section OK for stress”}) \]

   The general form of this logic expression is as follows:

   \[ \text{if}(\text{condition}, \text{true\_output}, \text{false\_output}) \]

   Note that you can use this kind of expression to define variables using a condition. The outputs can be values, expressions or further logic expressions. For example:

   \[ a = \text{if}(b > c, 10, 20) = ? \]

   Check the following topic in Tedds Help for full details:

   Tedds Mathematics/ Functions/ Logical Functions

10. Now calculate your document to calculate the Tedds Show Field. You should find you have something similar to the following in your Progress Log and you will also see the output text on the page where you placed the Tedds Show Field.

11. Change some of your input values and re-calculate a few times to test your full calculation and both the pass and fail output of the Tedds Show Field.

What Next?

Congratulations! You have completed the final exercise in the guide and are ready to begin using Tedds to its full potential.

Here are a few things you could try next:

- Create another Tedds Show Field similar to that above for the slenderness check - following is the logic statement you would use for this:

<table>
<thead>
<tr>
<th>Condition</th>
<th>check_slender &gt; 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>PASS</td>
</tr>
<tr>
<td>No</td>
<td>Section fails</td>
</tr>
</tbody>
</table>

- Create a Tedds Show Field to give the overall status of the section, checking both slenderness and stress. Try the following:

<table>
<thead>
<tr>
<th>Condition</th>
<th>and(check_stress &lt;= 1, check_slender &lt;= 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>PASS</td>
</tr>
<tr>
<td>No</td>
<td>Section fails!</td>
</tr>
</tbody>
</table>

- Take a look at Tedds Message Fields. The input for these is the same as Tedds Show Fields but their output is displayed in a Message box, rather than in the document. You will see examples of their use in the Tedds Engineering Library Calculations, for example the RC Footing design calculation.

- Try creating Messages using the Value of Variable option to show the values of the minimum area and radius of gyration in the Log before the Data List is displayed.
Of course there’s much more for you to discover. We wish you an enjoyable and productive time in using the program in your day-to-day work, and exploring its capabilities more fully.

If you would like to read up on further information about Tedds, then we would recommend the Tedds User’s Guide. You will find this in the Documentation folder within the folder to which you installed Tedds. The manual is in the electronic .pdf format. The information in the manual is also available within the Tedds Help system, which you can access in the usual way.

Some Tedds dialogs have context sensitive help. To see this simply click the Help button in the dialog.

We also run training courses in most locales, for further information on availability contact the Tedds support team in your region, simply click the Support icon in any of Tedds’ automated calculations.